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INTRODUCTION contain line geometry to represent

With Autodesk® InfraWorks, you
can create compelling 3D models
of real places, and then sketch
proposed improvements that are
realistic and interactive.

This training module helps you
search for, import, and configure
data to build a model of your area
in Autodesk® InfraWorks. Each
lesson covers a specific type of
data, going in the recommended
order from terrain to 3D models.
All the examples use the city of
San Francisco, California.

WHAT NEW CONCEPTS DO |
NEED TO UNDERSTAND?

GIS DATA

GIS data is intelligent data: it

has a representational aspect
(geometry or an image) as well as
information. You import GIS data
into Autodesk InfraWorks to create
your base model.

There are two basic types of
GIS data:

Vector data is geometry that
represents real-world objects and
their metadata. For example, a
GIS data file for city streets would

the streets, but it would also
contain attributes, such as the
name of each road, when it was
last maintained, the number of
lanes in each direction, and so on.

» Raster data is images, such as
photographs. It does not contain
attributes, but the pixels in the
image are “georeferenced,” so
they know where they are in the
real world.

When you create your base
model, start with the following:

> Terrain

The terrain establishes the
elevation of the model. All other
data is draped on top of it.

» Ground imagery

Ground imagery is usually an
aerial photograph of the model
area. It makes the model look
realistic.

> Transportation

Roads, railways, bike paths,
and such help you locate other
features.

We recommend that you always
include those three types of
data. After that, you can add the
following:
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> Water (recommended
for realism)

> Buildings (or building
footprints)

> Other ground data (parks,
zoning, parcels)

> City furniture (hydrants, bus
shelters, and so on)

> Utility data (streetlights, sewer
lines, storm-water lines)

> 3D models representing
real-world items (individual
buildings, monuments, bridges)

COORDINATE SYSTEMS
(SPATIAL REFERENCE
SYSTEMS)

A coordinate system specifies
how the geography was projected
(from a global reality onto a flat
surface) and it specifies where
exactly it is located in the real
world.

You don’t need to know very
much about coordinate systems
to use Autodesk InfraWorks. Here
are a few pointers:

> Do not specify a coordinate
system for your model—Autodesk
InfraWorks works best using its

s
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native coordinate system, and will
transform data into that system.

> Autodesk InfraWorks can
often find the coordinate system
information it needs within the
data source files themselves.

However, if the Geolocation tab
displays a yellow warning icon
when you import the data, you will
need to find out the coordinate
system for the data and specify it.

> If you need to find out
the coordinate system for a
data source, you can check
its metadata. These training
exercises cover that.

METADATA

Metadata is data about data. It
varies from data source to data

source, but can include things like:

> What the features represent
> How they were captured

> The time period represented
> The coordinate system used

> Attributes (road names,
number of lanes, who maintains
them, speed limit, surface
material)

Metadata is stored in XML

or HTML format, so you can
open it using a text editor or
browser. Generally, metadata
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uses standards established by
the Federal Geographic Data
Commission or ISO.

as draping the data on the terrain
or creating tooltips. Most of the
configuration options are covered
in these training lessons.

SCALE OF DATA

For some data, particularly
ground imagery, you may have to
choose between data sets that
were captured at different scales.
Large scale data generally covers
a smaller area, but with greater
detail (like a close-up). Small scale
data covers a larger area with less
detail (like zooming out).

DATA MAPPING

When you bring data into
Autodesk InfraWorks, you map
the attributes of the original data
to the attributes of the Autodesk
InfraWorks model. For example,
when you import roads, you find
the attribute that specifies the
road name and map that to the
Name attribute.

There is rarely a one-to-one
mapping. Usually, the original
data has more attributes than
Autodesk InfraWorks supports,
but it may not have the same
attributes that Autodesk
InfraWorks does. Once you map
the attributes and import the data,
you can see only the Autodesk
InfraWorks attributes—you do not
have access to the original data
attributes any more.

There are other things you can
do when you import data, such




TERRAIN, GROUND IMAGERY,
AND ROADS

The bare essentials for a model
are terrain, ground imagery, and
roads. Terrain establishes the
underlying surface on which other
data is draped. Ground imagery
provides a realistic background
for your model. Roads provide an
easy reference point for location.

WHAT IS TERRAIN DATA?

Terrain is often called elevation
or topographic data. It is usually
in raster format, and includes
both a picture file (such as aerial
photography) and a world file
(locating the picture in the real
world, or georeferencing it).

NOTE:

You can also retrieve terrain data
in a vector format. Such data
represents the contour lines of the
terrain. Autodesk® InfraWorks can
create a terrain from contour lines,
but you will get better results from
raster data.

Be sure that you download both
the image and the corresponding
world file, if required. The
following table shows which
formats require such files.

File Format Picture File | World File
Extension Extension

Arcinfo ASCIl | *.asc

Digital Elevation | *.dem

Model

Erdas Image *img *igw

jpeg “jpg/*jpeg | *jgw

MrSID *sid *sdw

TIFF * tif/ tiff *tw

WHAT IS GROUND IMAGERY?

Ground imagery is often called
orthophotography or aerial
photography. It can include an
actual photograph or a scanned
topographical map or site plan.
It is always in raster format, and
includes both a picture file (such
as aerial photography) and a
world file (locating the picture in
the real world, or georeferencing.

Make sure that you download
both the image and the
corresponding world file, if
required. This table shows which

NOTE:

Aerial photography can be stored
in very large files, so they may
take a long time to download.
Older images may be free, but
very recent ones will probably
cost money to download. Often
a picture from a few years ago is
sufficient for modeling purposes.
Also, color imagery may be
harder to find than grayscale
images.

WHAT IS ROAD DATA?

Road data is always in vector
format, and is often stored in
ESRI Shape files. If possible,
download road data in SHP
format, but DXF is also
supported. Shape files come in
sets, and you must have these
three:

File Purpose
Extension
SHP Geometry. For roads and railways,

this is linear geometry, and usually
represents the center lines of the

formats require such files: roads.
DBF Attribute information
File Format | Picture File World File SHX Links together and indexes the
Extension Extension other two files.

Erdas Image | “.img “igw Downloads may also include

jpeg *jpg/*jpeg | “jgw a PRJ file, which contains

MrSID *.sid *.sdw projection and coordinate system
TIFF * tif/* tiff * tw information.
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HOW SHOULD | STORE MY
DATA?

Use these guidelines when
storing terrain data:

1. Create a Project folder to
organize all your data.

2. Under the project folder,
create a folder for each data type
(Terrain, Ground Imagery, and
Roads).

3. When you extract the
downloaded zip file, create a
target folder for it under the data
type folder.

Name the target folder something
recognizable, and include the
source of the data—for example:
USGS SF DEMs.

HOW DO | FIND DATA?
This lesson will use the USGS

website, which is an excellent
source of free data.

ooooooooooooooooooooooooooooo

IMPORTANT NOTE: \Websites
change frequently. Instructions
here were accurate at the time

of writing, but we cannot guaran-
tee that they will remain so.

ooooooooooooooooooooooooooooo

Some sites tile the data, to

make each download a more
manageable size—for example, a
city may be divided into multiple
tiles. Some local sites link to
USGS data, but have their own
method for finding, selecting,
downloading, and viewing the
data. You can also download data
directly from the USGS National
Map Viewer.

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

How do | retrieve terrain, ground imagery, and road data?

The USGS website has terrain, ground imagery, and transportation data for most of the United States.
For other areas, you might try www.fao.org/geonetwork or www.gadm.org.

NOTE: Websites change frequently. Instructions here were accurate at the time of writing, but we cannot

guarantee that they will remain so.

1. Go to http://viewer.
nationalmap.gov/viewer/.

2. Click Download Data at the
top of the window.

| swasch P

ZUSGS €3 Viewer

o Kithes Book Mss [Mag Mawgatin)
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3. Under Download Options, set Download options (x)

the reference area to Counties. Choose a reference area, then click on the map.
Counties| m

Since the city and county of e ; -

San Francisco are the same Click here to zoom in 3 more levels.

geographically, we can select the -—0Or--

entire area we want by county. You are zoomed out too far to download by map

extent. Click here to zoom in 4 more levels.

4. Zoom in to the target area by
double-clicking it repeatedly,
until the county outlines appear.
Select the target county.

5. Click th selected county to ' g Fankrandsce (Desa]
see your options. A '

Layer: Counties or Equivalent
State: California

Download Zoom To More ¥
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6. Click the Download link and
select the themes and formats

you need.

Theme Format
Transportation Shapefile
Elevation ArcGrid
Orthoimagery JPG

7. Click Next to select data.

For Orthoimagery, select the color
images for San Francisco. Then
click the Elevation header (at the
bottom). For Elevation, select

the ArcGrid option at 1 arc per
second.

NOTE: Generally, one arc per
second is sufficiently precise. Data
captured at 1/3 arc per second
will be larger and will not give you
much better results.

The Transportation results are
not listed because there is only
one option, so there are no
choices to make.

1
|

wx
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USGS Available Data

Selected item type: Counties
Selected item name: San Francisco, California

The following themes and products are available in various formats for download in the
reference area polygon you selected. Check one or more and click 'Next.' Products will be
added to the Cart on the left side of the screen.

Theme Format
US Topo GeoPDF -
Historical Topo Mapsm
Structures File GDB 9.3.1 -
Transportation Shapefile -
Boundaries Fle GDE 9.3.1 -
Geographic Names Text v
USGS Map Indices File GDB9.2
Hydrography File GDB 9.3.1 -
Land Cover W
Elevation W
orthoimagery -

If a checkbox is disabled, the area you selected
Click theme names to see theme descriptions.

is too large.

'_UGGS m' bie Crata - - - x

| mnpmlmmwmmommmml 1 & sadected theme ks not

| it only has ome product. LUss the checkboses bo ssiect the procucts you want
Mnﬁﬂv— Chck Land Cover, Blavation, and Orthaimagery products to praview
thair footprints on the map.

pemedy 1

Mard Year Type Rusc Units Ty=

wascr__|
~

Colew
™) Owhomugery - SanMateo  Oct 2005 Coler 015 meter  Dynamic |

USGS Avalable Data

Orthemagery (1 products}

This page ksts themas providing mors than one product. I a selectad theme Is not
listed, it only has one product. Use the checkbores to select the products you want
under each thams, Chck Land Cover, Elvation, and Orthaemagarny

thew footpnnts on the map.

PrUGUCtS T preveaw

(Elevation (6 producita)

Product

Masonal Eksvation Cistasst
Mowst Bone
¥ arc secand) Pre-packaged Eleat
Fl Aocmln Aemla

Most Year Type Resc Unts Tyw |

L
secong Sed |y

County. CA
g NAF il Band) UTM Zone  Best Best
] Aala dalal

4B 10 meters Dynamic| |y

Bevation (6 products)

Back

Ozt

Hananal Elgvanon
£ (13 are second) Pre But Bant

Bievat 13
packaged Flogt ey MBI Avada
- Best Best
{173 arc secand) Fre- Aol unal I 13

AavGna format

packaged

vt

06
v Maanl Ehevation O %
E 12.01- 20105 Elewat ¥
NED) 119 Arc Second o

t Elevation Distaset
WED) oA Second O 2010 Bt 13

| Back

rcond Stmed [y
secona Stamd [y
Srcong DYam | 1y

s Do £}
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8. Click Next until the selected Cart |
items are added to your cart.

Add items to the cart by using the "Download Data" tool in

Check over the contents of your the "Advanced" panel.

cart, and then click Checkout. Selected items:

Product Type/MName Format
Counties/San -
Transportation  Francisco, Shapefile ol
Califarnia
Apr 2011 0.3m
Color Counties/San
Orthoimagery - Francisco, JPG 0.30 meter =
San Francisco, California
CA
Mational
Eﬂ amhl mI{ 1 arc Counties/San | o
second) Pre- P UG =
narlkeanad California -
| Remove selected | Checkout

Owverlays Selection Cart

9. Provide your contact infor- Cart

mation and click Place Order.
Flease enter your e-mail address below. You will receive

a message containing links to download the data you
salected.

E=-mail address:

Re-enter &-maml sddrass:

hapter 2 About Terrain, Ground Imagery, and Roa



Autodesk® InfraWorks Training Guide: Finding and Impcy!{lg Data for your Model

Your order is acknowledged.

USGS will send you an email
containing links to download the
selected data.

10. When you receive the email,
download and unzip the files.

| TNM Download Cart -

| ¥our request has bean recewved. (Order ID: 312192).
Please check your e-mail for order details.
We suggest to noke the Order 1D in case you lose or do not receive the confirmation e-mail.
The Crder ID can be used track your order if you need to contact the THM Help Desk.

You can use many extraction programs (such as WinZip) to extract the
compressed files. However, the built-in Windows extraction program will
not extract the .gz compressed files used by USGS.

© © © 0 0 00 00 0000000000 0000000000 000000000000 0000000000000 0000000000000 000000000000 00000000000 00

How do | get terrain data into Autodesk® InfraWorks?

Add the terrain data as a raster
data source.

1. In the Data Sources panel,
click Add File Data Source >
Raster.

Chapter 2 About Terrain, Ground Imagery, and Roads
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2. Select both extracted .adf b8 Select Fles
files.

Organize v New folder

. S
¢ Favorites i

. TinyTown
M Desktop
l4 Downloads

«» Recent Places

) Libraries
2, Documents
. Music

2=, Pictures

Documents library
grdn38wl23_1

Name

dblbnd.adf
hdr.adf

Eﬂ metadata.xml
prj.adf
sta.adf
w001001.adf

QIR | Terain vata » niwizs > gunsewizis | +r|

0 e

Arrange by: Folder ~

‘, Videos

w001001x.adf

W CCS5CR1490WL2 |
"i System (C))

- 4|

File name:

The data source is automatically
configured because the data has

I

"w001001x.adf” "w001001.adf"

Data Sources

elevation data (Z value). Group by: Feature Type ~ Show: All

3. Double-click the data source
and click Close and Refresh.

Chapter 2 About Terrain, Ground Imagery, and Roads

S X B

Source Type

v lRas‘cer Files (*.adf *.asc *.bt * V]

[ Open |vH Cancel ] |

£ ® o

Status Date Loaded
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The terrain data appears in the
model.

Set the model extents to match
the area of your model. Then, if
you bring in data that extends be-
yond those extents, the data will
be cropped at the extents auto-
matically.

4. Click Manage tab > Settings
panel> Model Settings on the
ribbon.

5. Under Extent, where you
see Defiine Interactively, click
Polygon.

Chapter 2 About Terrain, Ground Imagery, and Roads
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6. Draw a polygon around the
terrain data. Double-click when
you are done.

7. Click Save in the Model
Settings dialog box.

Chapter 2 About Terrain, Ground Imagery, and Roads ’ g -
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How do | create a
model?

Create a new model in Autodesk®
InfraWorks and then import your
terrain.

1. Click New on the Start page.

2. Enter a name.

Don’t bother with schema or
model extents for now.

3. Click OK.

Autedesk Infrastructure Modeler 2012

Models

Online Models

Present Manage

Autodesk

Settings

L OB

Hame:

pefing Model Extent

Chapter 2 About Terrain, Ground Imagery, and Roads
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Extra Credit: How do | retrieve terrain data from a local site?

Use your search engine to find
other sources of data.

1. Enter your search string in
a search engine.

The search finds a site hosted
by the University of California
at Berkeley. It includes USGS
data, as well as data from other
sources.

2. Scroll down on the site to
look for topographical data.
Click the link for your area.

Chapter 2 About Terrain, Ground Imagery, and Roads
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gis+data+dem+terrain+download+san francisco + califi

J gis+data+dem-+terrain+downlo.. “ + l

[« ) @ hitps://www.google.com, search7q=GIS%2Bdata%2BDEMS2 Bterrain%z2 Bdownload#2BSan Francisco %2B California&ie=utf-8&oe=utf-§

(& Most Visited ~ |g—| Outlook Web App || Timecard 40 New Busines... a Campaign for Be...

+You Search Images Maps Play YouTube News Gmail Drive Calendar More

GO Lng.e GIS+data+DEM-+terrain+download+San Francisco + California

Web Images Maps Shopping More Search tools

Any time = All results ~ San Francisco, CA ~

GIS - The University of California Berkeley Libraries
www.lib.berkeley.eduw/EART/gis.html -

Jun 10, 2011 — The majority of the library's collection of GIS data is available on ... China
National Data; DAAC GTOPO30 —global digital elevation model (DEM) ... map

database of China; Eco-Atlas San Francisco Bay --modern and ... for California;
TerrainBase: Worldwide Digital Terrain Data ... Downloadable GIS Data ...

Data - Geospatial Innovation Facility - University of California, Berkeley
gif.berkeley.edu/resources/data_subject.html ~

Topologically Integrated Geographic Encoding and Referencing system (TIGER) ...
Historical Climate Station Data or download via FTP. ... Naticnal Digital Elevation
Models (DEM) available through custom webGIS ... San Francisco County GIS ...

download dem data here - Free GIS Data - GIS Data Depot
data.geocomm.com/dem/demdownload.htm| ~

USGS DEM Resources. The GeoCommunity and Digital Data Services are pleased to
provide you with this handy USGS quad index. Please note, some of the ...

Terrain Modeling and Fly-by Animation
www.colorado.edu/geography/foote/maps/assign/hotspots/terrain.html -

Oct 3, 2011 — Terrain Modeling and San Francisco Area Earthquakes ... additional GIS
data from the web; (2) work with Digital Elevation Model (DEM) files ... Step 11:
Downloading and Importing the Raw Data--The Digital Elevation Models ...

GIS data and resources over the internet - NMSU Web Hosting
web.nmsu.edu/~dwdubois/gislinks.html =

Mar 15, 2013 — Sources of DEM, elevation data and relief images ... USGS EROS DEM
data 1:250,000 - Digital Terrain Elevation Data ..... Data NWS San Francisco Bay Area
(data covers Bay Area and all CA); Kavouras weather data in ESRI GIS format .... PA
DOQQ download area from the Pennsylvania Spatial Data ...

GIS Data Sources - ESRI Conservation Program
www.conservationgis.org/test/organizations/datasources1.html ~

i 10jpg UPEG Ima... — What

e

.‘ GEOSPATIAL [ share|  [BLike (47| [Coe costom seron

2>

INNOVATION
?f\i\ F A c I L I T Y HOME ABOUT SUPPORT SERVICES RESOURCES
Cutting-Edge Mapping Technology at UC Berkeley Software Hardware MNetworking Funding

Resgurces > Data > Data by Subject

DATA RESOURCES BY SUBJECT

Topography & Elevation

BARD (SF Bay only)
Digital Elevation Models (DEM)

Cal-Atlas (CA only)
Digital Elevation Models {DEM)

CSU Northridge Geography Dept (CA only)
Digital Elevation Models {DEM)

Policies
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3. Look for elevation data.

This site has DEM files, which are
perfect.

4. Click Elevation > 7.5 Min
DEMS to see this tiled map of
the Bay Area.

The San Francisco area is
represented by 2 tiles in the lower

third of the map.

5. Click one of the tiles.

a USGS

science for a changing world

Home
Historic Maps
Imagery »

More Maps

The New BARD
Content

As the digital mapping
world has changed,

BARD has also changed.

Older formats of USGS
data are no longer
available at this site
with the exception of
elevation (DEM) data.
Please visit the USGS
Seamless web site, the
USGS Store, or the

National Map for maore
recent data.

7.5 min DEM Index Map

= USG

science for a changing world

San Francisco Bay Area Regional Database (BARD) |

Home

Historic Maps »

Elevation 3
Imagery 3
More Maps

7.5 Min DEMS

Scroll over the
displayed image to
select a map. Click to
begin download of the
compressed (gzip) files.

The 7.5-minute Digital
Elevation Models (DEM)
in this dataset have 10
meter grid spacing and
are projected in UTM
Zone 10, NAD 83.
Elevations may be
meters or feet. The
format is defined by the
1998 DEM Standard .

Software to view these
files can be downloaded
from this USGS site.

Chapter 2 About Terrain, Ground Imagery, and Roads

ir.usgs.gov/getDEMSMa

(] Most Visited ~ 0| Outlook Web A

.| USGS Home
Contact USGS
Search USGS

BARD's goal is to
provide USGS mapping
| data that is not readily
available on other

—| USGS data sites. These
=~ | include historical maps
for the Bay area,
individual elevation
]| (DEM) quadrangles
Fial| (1:24,000 scale), and
county compressed
orthoimagery. Links to other USGS data such as bathymetry are
also provided.

Several compression methods are used for the data. Directions for
uncompressing the data files are listed on the download pages.
However, uncompressing these files may require plug-ins or utility
programs not provided by the USGS.

Comments about changes to the site are welcome. Please email
the Web Team listed below.

7.5 min DEM Index Map

10.jpg (JPEG Ima_.
e USGS Home

# Contact USGS

j Search USGS

7.5 Min DEMS Index

Q) (&

>» [ Bookmarks ~
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6. When prompted, use the arrow
next to Save to select Save As.

7. Save the data in a sub-folder
of the project file, as shown.

8. If you need more tiles,
download them in the same
way.

Chapter 2 About Terrain, Ground Imagery, and Roads : 15

The 7.5-minute Digital
Elevation Models (DEM)
In this dataset have 10
meter grid spacing and
are projected in UTM
Zone 10, NAD 83,
Elevations may be
meters or feet. The
format is defined by the
1298 DEM Standard .

Software to view these
files can be downloaded
from this LS

Do you want to opén or save sf_north.dem.ge (823 KE) from bard.wr.usgs.gov?

] Open Save D Cancel

| http//bard.wr.usgs.gov/bard,/elevation/sf_north.dem.gz |

|| ¢ Libraries » Documents ¢ San Francisco Project » Temain Data » USGS SF DEMs |
S

View Tools Help

b Open Share with - E-mail Burni MNew folder
tes Documents library
Town USGS SF DEMs
aop
sf_north.dem.gz
mlaads

T ey b
meters or feet. The
format is defined by the
1398 DEM Standard .

Software to view these
files can be downloaded
fram this

Do you want to open or save sf_south.dem.gz (1.57 MB) from bard.wr.usgs.gov? x B i

Open Save ~ @8 Cancel

. ]
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WHAT IS GROUND IMAGERY?

Ground imagery is often called
orthophotography or aerial
photography. It can include an
actual photograph or a scanned
topographical map or site plan. It
provides a realistic background for
your model.

Ground imagery data is always
in raster format, and includes
both a picture file (such as aerial
photography) and a world file
(locating the picture in the real
world, or georeferencing it).

NOTE: Aerial photography can be
stored in very large files, so they
may take a long time to download.
Also, older images may be free,
but very recent ones will probably
cost money to download. Often

a picture from a few years ago is
sufficient for modeling purposes.
Also, color imagery may be harder
to find than grayscale images.

HOW SHOULD | STORE
GROUND IMAGERY?

Use these guidelines when storing
terrain data:

1. Create a Project folder to
organize all your data.

2. Create a Ground Cover Data
folder for each project.

3. When you extract the
downloaded zip file, create a
target folder for it under the
Ground Cover Data folder.

Name the target folder something
recognizable, and include the
source and format of the data—
for example: USGS SF TIFFs.

HOW DO | FIND GROUND
IMAGERY?

Use your web browser to find
and download ground imagery.
A good search string includes
the following: GIS + data + color
+ Aerial + imagery + download +
[your area name]

GIS

A Geographic Information System
stores, manages, and analyzes
goegraphical information.

Download

Include this term to avoid sites
that merely display terrain data
without the ability to download it.

Your Area Name
Start with a small area and
expand from there. For example,

specify your city or county name.
Include the state name to make
sure you get the right data.

Make sure you download both
the image and the corresponding
world file, if required. This table
shows which formats requires
such files:

File Format Picture File World File
Extension Extension

ErdasImage | *.img *igw

jpeg *jpg/*jpeg | “jgw

MrSID *sid *sdw

TIFF * i/ tiff *Hw

As you look for ground imagery,
keep these tips in mind:

> Look for natural color
orthophotography

> Follow links from one site to
other sources of data

> Look for “mosaics” (titled
photos by area)

> If you find imagery that is in

a different coordinate system or
projection, Autodesk InfraWorks
will transform the incoming data to
the model’s coordinate system.

> When you download and
expand the zip containing the
data, you will probably have a
large photo file and a small world
file, as well as an .aux and .txt file—
you can ignore the last two.
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How do | retrieve ground

This exercise retrieves grayscale imagery. See the Extra Credit exercise for a way to download color imagery.

imagery?

GOOSIE GlS+data+color+aerial+imagery+download+San Francisco California

1. The California State Chief
Information Officer WIKI has
some promising looking data.

2. This site directs us to another

Web Images Maps Shopping More - Search tools

About 782,000 results (0.62 seconds)

Imagery - California State Chief Information Officer Wiki
www.cio.ca.gov/wiki/lmagery.ashx ~

Feb 11, 2011 — Please go to the NRCS data gateway if you can downlead a county or 2;
... Theme Uses - Land reference image coverage of geographic areas, ... San
Francisco UA, Imagery-hi-res 1', 2008, 250gb ... Currently offered services include: -
California 2005 CIR aerial imagery in 2 variations (CIR/false color, ...

California Aerial Photo Collection - Map & GIS Data Collection ...
www.lib.ucdavis.edu/dept/mapcollection/aerial.php ~

California. UC Davis: The UC Davis Shields Library has an extensive collection ... This
collection emphasizes San Francisco and the East Bay area. ... Natural color and color
infra-red products are available for some areas. ... free public access to downloadable
topographic maps and aerial photographs of the United States.

Local GIS Data | SUL

lib.stanford.edu » Groups » Stanford Geospatial Center =

2003 High resolution orthoimagery for: San Francisco (1ft) and Monterey peninsula (1ft,
2ft, and 8in}. ... 2001 and 2006 Stanford aerial photos (color, 3in) Available at Branner.
... Links to interactive GIS websites, maps and downloadable aerial photos and habit
data. Northern California Earthquake Data Center (NCEDC).

2010 San Francisco County, California Aerial Photography - Landsat
www.landsat.com » ... » San Francisco County CA ~

2010 Aerial Photography of San Francisco County, California. Imagery compatible for
GIS mapping in ArcView, ArcMap, Erdas, Maplnfo, AutoCAD, & Global Mapper. ... color
imagery; Format = MrSID; Compatible = all ESRI products, (ArcGIS, ... You get full utility
of the data - not just a jpg snapshot! ... Free FTP downloads ...

location: http://datagateway. TECCOH?J%GLOGY AGENCY
nrcs.usda.gov. GOV ;
Navigation = Imagery Discuss (U)| ‘VIEW Page Code
* Main Page Modified on 2011/02/11 20:39 by David Harris

Categorized as Geographic Information Systems
Random Page
Create a new Page
All Pages
Categories

» Imagery

Administration
File Management

Login/Logout
Language Selection
Your Profile

Create Account

NAIP 2010 Update - Compressed county mosaics are beginning to show at the NRCS Data
Gateway. Delivery of compressed county mosaics should be complete by about end of October,
2010, and the full res tiffs will be available likely be end of December, 2010. Please go to the
NRCS data gateway if you can download a county or 2; if you need a large portion of the
state, or the full state, please contact USGS (costergren@usgs.gov or ddecker@usgs.gov)

USDA Geospatial Data Gatewaylt!ttp:f‘}’ﬂataga'heﬂw-ljrﬁ.us'ﬂﬂ.gﬁv I

Chapter 3 About Ground Imagery
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3. This site has a way to order
imagery by county.

4. Select the state first, then
scroll down to find the county
you want.

5. Click the double arrow
to move the county into the
Selected Counties list.

Chapter 3 About Ground Imagery

Browse by Subject
Natural Resources

" Conservation Service

I Farm Services Agency

I Rural Development
Natlonal Geospatial

I Management Center
[NGHC

b Aerlal Photography Fleld
Office (APFO)

b Web Soll Survey

I Soll Data Mart

b eFOTG

F Geo.Data.Gov

b APFO Customer Order Entry
System
USGS Maps, Imagery and
Fublications

F Natlonal Atlas

I Natlonal Map Viewer 2.0
US Census Bureau
¥ Geography

b Download TIGER/LIng
Shapefiles

b Download Public Land

Surw stem Data

|l usDanRCEGeaspatial Data Cat

o | & datagateway.nres MEELHOV/C

‘fou are here: Home

Welcome to GDG

the one stop source for environmental and natural resource data
The Geospatial Data Gateway {GDG) is the One Stop Source for

environmental and natural resources data, at anytime, from
anywhere, to anyone. The Gateway allows you to choose your area
of interest, browse and select data from our catalog, customize the
format, and have it downloaded or shipped on CD or DVD.

This service is made available through a close partnership between
the three Service Center Agencies {SCA); Natural Resources
Conservation Service (NRCS), Farm Service Agency (FSA), and Rural
Development (RD).

System Status

USDANRCS: Ceaspanial Data Gateway Ovder Data

[ Most Visied = | ) Cusloak Web App [ ]

Order by County/Counties

Usimg tre panal in tha midete

e
putten
YOUR
ORDER panel on the far right.

Data Order

[ Want To...

© Order by County/Counties

© Order by State

© Order by Place

© Order by Bounding
Rectangle (Latitude and
Longitude)

© Order by Interactive Map
- Custom Area Of
Interest{ADI)

© Find Avallable Data for
the U.5.

© Check Status of an
Existing Order

GeoSpatialDataGatewa

Home  Slabus Maps

WHERE

Seleet S1ane for order:

Sacraments
San Benito

San Bermarding
San Diego

San Francisco
San Joaguin
San Luis Ohispo
San Mateo

Help  FAQ  ContadlUs  A*-
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6. Submit your selection. eoSpatialDataG
e

TS

7. Scroll down to find the Ortho e w702 e i R

Imagery section.

cted area of YOUR ORDER

8. Select an overview map and - ,
the most recent mosaic map, then ko will provic - : wste, 1 mop 0022 B ¥
click Continue. S o So— -

GeoSpatialDataGateway
9. The site tells you the
projection used for the data
and how long it will take to
download.

Review the information and click ¥ i ' : ' :
of the 3
Continue.

(50.00 US) FOR EACH CD and ONE-HUNDRED DOLLARS ($100.00 US) FOR EACH
ove.

Chapter 3 About Ground Imagery .
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10. Enter your contact information
and click Continue.

11. Review your Order and CIiCk Order areaWhere):  (San Francisco County, California

Place ordel‘. " « Digital Orthe County Mesaic of 7.5 quads by APFOD, 1 map 57.064 MB

Format: Native

uwkaUTH to county MADSZ

ORDER GENERATED

The order is generated.

You will receive an email when
your order is ready to download.

It will tell you the format of the

image(s) and the projection(s)
used, and gives you link(s) to

Chapter 3 About Ground Imagery
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download the image(s).

12. Unzip and save the datain a
sub-folder of the project file, as
shown.

The highlighted file is the image.
The .sdw file is the world file.

@Ovl | = San Francisco ijct.l-_l Gre;d Cover Data » SF orﬂ-o_l'maEry UsDa -: +4 | Search SF artho_image ylsoa O
[ File Edit View Tools Help - - -
i Organize = Open Share with = E-mail Bum New folder = I @
Faworites = Name Date m Type 5
L. TinyTewn gway_2036689_01_MDOGARFO. b 1071572002 539 PM  Tex mer T KB
I Deskiop ortho_el-1_5_cali75.aux 1071572012 539 PM X 8 KB
l Downloacs onna_el-1_s cal75s0w 10/15/2012 539 PM SDW File 1 KB
b Recent Places ortho_e1-1_5_ca075.sid 10/15/2012 5:39 PM__ SID File 58,409 kB
ortho_el-1_5 cad73.5id.txt 10/15/2012 539 PM  Temt Document TKB
 Libearies ortho_el-1 s ca075.bit SI9PM  Tex 1 KB
% Doouments 2 ortho_sample_metadata.htmi 35
4 Music

&, Pictures

© © © 0 0 0 000 00 0000000000000 0000000000000 0000000000000 0000000000000 0000000000000 0000 0000000000 o

Add the ground imagery as a
raster data source.

1. In the Data Sources panel,

click Add File Data Source >
Raster.

Chapter 3 About Ground Imagery

Mh,.--

Home View Present Manage Collaborate Help

A E
) e
i a4 e @ E
Scenarios Storyboards Watermarks Render Snapshot  Full
Screen

Storytelling ([ Imagery | View

—

- - -
|E

A

% o

Date Loaded

Hide Details
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2. Select the .sid file. % Select Files - _ n
GGl |« 0070 Corer Doto > SF otho imagery USDA = 4y | Secrch s¢ oo imager
S —

= .

Organize = MNew folder
¢ Favorites i
; i Documents library bt
L. TinyTown 5F ortha_imagery LUSDA
B Desktop Name

i Downloads
=p Recent Places

ortho_el-1_s_cal75sid

~ Libraries
" Documents
4. Music
&, Pictures
! Videos

(L]

Ay COSSCEI400WL2 -~ o

= | Raster Files (~adf “asc bt * =

File name: ortho_el-1_s_cal75.sid
[open [] [ concel |

The data source is automatically M S ———— —
configured because the data has e T = T e
no elevation data (Z value). B Data Tabie

Chapter 3 About Ground Imagery



Autodesk® InfraWorks Training Guide: Finding and Impc}m{lg Data for your Model

3. Double-click the Data Source.

4. Give the data source a more
recognizable name.

5. Click Close & Refresh.

Chapter 3 About Ground Imagery

E Data Source Configuration

HamE SF groi

Desoription

Geo Location

Close & Refresh 0K Cancel

Home  View  Analyze

L 2
Data | Model | Manage
Sources Exploner Surface Layers

Prégent

l‘.'.._-.-L_'.:]q:

borate  Help o-

A Properties v E
roperties !. 3 E

Dt e
B Data Table P




Extra Credit: How do | retrieve color imagery?

You can often retrieve free color imagery for areas in the United States from the USGS site. It is a time-
consuming process, but the results make your model look far more realistic.

B

1. Go to http://viewer. m
nationalmap.gov/viewer. EEE o o e

Base Data Layers

<] = Z8 US Tono Avadabisty

<[] = L Geopraphic Hames (GHIS)
“7] = @ Structures

] = T Trenspartation

< = L Governmental Unit Baundarics
S = Map Indices

7] = I Mydrography (HHD)

] - Z@Land Caver

" opa | 1magery Tapa | Imwu‘\' [mz‘d-mn][rnsrﬁue] 1

=] |__| = Elevaticn fwailability

<[] = Ll Elevation Cantours - Small Scale
=[] =+ I Imagery

S| = L@l Scanned Toao Maps

“E] = Ll Reference Polygons

C J

Matural Hazards

Other Featured Data

User Added Content

Favarites

2. Click Download Data at the
top of the screen. tive Tool: Download Data

] | “Iln-linli options E-'l
—g Click here to draw and download by bownding
bo.

Chooee & refarence area, then dick on the map.
|Inb: 24K .

Index 24K won't display at the curment scale.
Click here to zoom m 3 more beyels,

¥ou are zoomed out koo far to download by map
I:r.‘l:ent. Llick here to zoom in 4 more levels.

Click here to download coorgenats B

o tovco oo




NS

3. Click Here to zoom in four more
levels.

] 3: i =
Click hare to draw and download by
x|

Choose a reference area, then dick on the map.

4. Pan to the area of interest.

[RURTTRTRTININTY I‘ .-h:-l‘-,-

[fl=HIi

RAN
FRARCISCOC

San
Franeciseo
San

FHABNCE

Harstrs
P

5. Select one of the gridded areas. Search

Overlays | Selection cart | 4] | Standard | Advanced I Annotaton | Active Tool: Download Data
et ers e -, | RN Download opti L]
Jd tify Lary s, I‘I élmlm I;_Iqo T heE e Sl o
6. Select a second gridded area. e e G i TR
e 4 i Index 24K -
oW -3outo m all results. E 4 g o
Sherwing 1 - 3 aut of 3 from all It HE \\ e J ’ Click here to download by
Lan Francisco N = i ifer i
7_ On the Ieft Side’ Click the Reference Polvﬂgﬂrr:s":- 1:24K Index = "---.\_c'u{\- = = 3 - Click here to download by coo
Download Zoom To More ¥ = 3 "!_,__ ";"ltllsui‘kn‘_\_‘;.
All Results tab to see both S N
selections. Pl Bt b - ;i:."l'---’;
3 PN
8. Under the name of the first \ {-{:x‘
. . 1 !
area, click the Download link. | \ P
\ 1=
i
1 |
| \
N\%

——
e 4 - e
5: 3 Extra Credit: How c
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USGS Avallaple Data for download x

9. Select Orthoimagery and click
Next.

The following themes and preducts are available in vanous formats for download in the refersnos
area polygon you selected. Check one or more and click “Hext.'

Selactad itern type: Index 24K
Selzctad iterm name: San Francisco Maorth

Theme
IS Tooo
[C'Historical Topo Maps
C)Structures
] Trensportation
[|Boundaries
[lGeagraphic Ham=s
JUSES Map [ndices
[CHydroaraphy
[CICantawrs
L Land Caver

ﬂrdmlrn.uggg_’

If & checkbox is disabled, then the area you s=lected is too large. Cefine your area of interest with
either @ smaller bounding box, refersnce an=a, or cumsnt mag extent.
Click theme names to see theame desoriptions.

USGS Avallanlke Dama ror downkosad X

10. Select the most recent color

imagery option and click Next.
s the checkbowes to select speofic format of preducts yeu want under each theme. Click an the
products to greview their footponts an the map. Products will b2 added to the Cart on the left side

This item is added to the cart. of the scresn.

Orthaimagery {& products)

r .15m Color 615
|| Orthoimagery - Marin County 2011 Color Staged  JPG2ODNI
East, CA meter
[ AP {4 BEand} UTM Zone 108 A8 1 meters  Dynamic GeaoTFF
b Bvsailabrle :
| WA {4 Bandp UT Zone 10M Avvailable B 1 meters  Dynamic MG i
-
[ MAIP {4 Eand} UTM Zone 10N D55 48 1 meters  Dynamic JPG i |t
Available -




E Autodesk® Inf;' 1
11. Click the Selection tab and Overtays | Selection
repeat steps 8 through 10 for Cart

the other selection.
Add kems to the cart by using the "Dovwnlead Data®™ tool in
the "Standard™ panel.

Click on an item in the cart to see the product
footprint.

Selected ltems:
Product TypesHame Format

Agr 2011 0.3m
Coloe Indei 240/ 53n PG2000

Orthoimagery -  Francizco Marth
San Francisco, CA

Overlays Selection Cart

12. Click Checkout.

13. Enter r email r Please enter your e-mail address below. You will receive a
3 . er your email address message containing knks to download the data you
and click Place Order. selected.

E-mail address:

l |

Re-enter e-mad address:

1 |

> __épter 3 Extra Credit: How do | retrieve colc
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How do | add multiple imagery files to Autodesk® InfraWorks?

When you retrieve ground imagery, it may be stored in many individual tiles. You can add all of them to

Autodesk InfraWorks at one time.

For color imagery, you receive an email listing each downloadable “chunk” of imagery. You must
download all the chunks and unzip the files into a single folder.

1. For each chunk, click the link in
the right-most cell.

2. Open or save each zipped file,
and unzip all of the resulting files
into a single folder.

3. Repeat the process for each
chunk, and be sure to put ALL of
them into the SAME folder as the
original chunk.

4. In Autodesk InfraWorks, in
the Data Sources panel, click
Add File Data Source > Raster.

5. Navigate to the folder where
you unzipped all the chunks and
arrange the files by type.

6. Select the set of JPEG or TIFF
images (either one is fine).

7. Click Open

e

Home  View Present

i E M e@H

Scenarios Storyboards Watermarks Render Snapshot  Full

Screen
Storytelling || Imagery | View

Analyze Manage

o bv: Feature Type ~ S

-8 B X R g

3D

% o

Status Date Loaded

Hide Details

PeWEwN g

Collaborate  Help

W

RE
k)

/1

Ovganize =

Favorites Documents library

1SG5 [

L. TimyTown

B Deskiop

R Downloads
2 Recent Places

.

JPEG image

- Libraries

- Docurments
. Music

TIFF image

=, Pictures
B vigeos

iy CCSSCELA90WL -

File name:

& |

XML File

~ | Raster Files (*a0f *asc "6t* =

Cancel

Open

Chapter 3 How do | add multiple imagery files to Autodesk® InfraWorks?
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8. Select all the files in the list and
click Open.

9. Double-click the new data
source.

10. Click Close & Refresh.

The ground imagery appears in
the model.

Ovganize =

¢ Favarites Documents library
). TinyTown IPEG image
B Deskiop == "

-
i Downioads 105EG535880_201104_0e3000m_CL_1jpg
ip Recent Places | = 10SEG535895 201104 0x3000m_CL_Lipg

105EG535510_201 104 _C3000m_CL_1.jpg

o Librasies 10SEG550775_201104_0x3000m_CL_1jpg
% Documents 105EG350790_201104_0:3000w_CL_Ljpg
d Music 105EGES0805_201104_03000m_CL_Ljpg
& Pictures = 10SEGS50835 201104 0w3000m CL ljpg  1/18/
B vigeos 10SEG550850_201104 (he3000m_CL 1jpg  1/18/2012 2:32 PM
10SEGES0865_201104_te3000m _CL_1jpg 2 232 PM
S COSSCBLAO0WLY ~ 4 T

File narme: “105EGS50865_ 201104 (x3000m_CL_ L * ltam:f Files (*.adf *asc “0t T:

Chapter 3 How do | add multiple imagery files to Autodesk® InfraWorks? P
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While the ground cover aerial
photo might show roads,

rails, and bike paths, GIS data
associates information like road
names, rail operators, number of
lanes or tracks, and so on with
the transportation geometry. This
lesson covers road data, but you
can also use the Extra Credit
lessons to learn how to import
bike paths (page 62) and railway
data (page 59).

Transportation data is always in
vector format, and is often stored
in ESRI Shape files. Shape files
come in sets, and you must have
these three:

File Purpose
Extension
SHP Geometry. For roads and railways,

this is linear geometry, and usually
represents the center lines of the

roads.

DBF Attribute information

SHX Links together and indexes the
other two files.

Downloads may also include

a PRJ file, which contains
projection and coordinate system
information.

NOTE: If possible, download
transportation data in SHP format,
but DXF is also supported.

HOW SHOULD | STORE
TRANSPORTATION DATA?

Use these guidelines when storing
transportation data:

1. Create a Project folder to
organize all your data.

2. Create a Transportation Data
folder for each project.

3. When you extract the
downloaded zip file, create a
target folder for it under the
Transportation Data folder.

Name the target folder something
recognizable, and include the
source of the data—for example:
UC Berkeley Roads.

HOW DO | FIND ROAD DATA?

You can use your web browser
search string, for example,
including the following: GIS + data
+ download + DOT + [your area
name]

GIS

A Geographic Information System
stores, manages, and analyzes
goegraphical information.

Download

Include this term to avoid sites
that merely display terrain data
without the ability to download it.

DOT
Department of Transportation
sites often have road and railway
data.

Your Area Name

Start with a small area and expand
from there. For example, specify
your city or county name. Include
the state name to make sure you
get the right data.

In this lesson, we will use the
SFGov data site for roads. If you
do the extra credit exercise, you
will also use the San Francisco
Metropolitan Transit Commission
site, and the Cal-Atlas Geospatial
Clearinghouse.

As you look for road and railway
data, keep these tips in mind:

> Look for a “resources” or
“interactive tools” link on the

page

> Do not download maps—you
need the raw resources to create
a map

> Look for infrastructure data

> Check any posted metadata to
find out the coordinate system for
the data

> When downloading road data,
look for centerline data
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Help

Developer

How do | retrieve

Q, strests x Results for "streets"

In this exercise, you will retrieve
data from a city-sponsored site. Clear Al Optioas

Name

P Street Names

View Types =gg A list of officially valid street names contained in the City's GIS Basemap
[ Datasets
1. Go to https://data.sfgov.org/. Charts

Street Space Permits

= M —
s =gg Street Space permits are generally issued for construction related work
[5] Calendars CI=1=W zuch as building construction activities or sidewalk repair work.
Filtered Views Showing 3 of 644 matching rows (view results):
External Datasets

2. Search for streets. Files and Documents RECEIPT_NUMBER 1134810  ToDateOnSign
Bl Farms StreetNoFrom 2917 HoursOfOperation

StreetNoTo 2917 SpecialCondition

3. Scroll through the list looking
for datasets and external datasets.

4. Click the external dataset Streets of San Francisco (Zipped Shapefile Format)
Streets of San Francisco. View of Street Centerlines excluding Paper streets, unpaved rights-of-way and pseudo streets.

5. Click the ZIP button under
External Link.

6. UnZip the resulting file to see
the SHP files.

7. Open the .pr;j file with a text M) Nﬂﬂfe
editor, such as Notepad, and see M stclines_streets.dbf

that the coordinate system is I:: stclines_streets.prj |
NADB83, CA-lll and uses US feet.

stclines_streets.shp
M stclines_streets.shx

®O0 M stclines_streets.prj

PROJCS[NAD_1983_StatePlane_California_III_FIPS_0403_Feet,

Chapter 4 About Transportation Data
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How do | get road data into Autodesk® InfraWorks?

IMPORT AND CONFIGURE THE
ROAD DATA

When you configure the data,
you will assign a style to make it
easier to see the roads. You will
concatenate the street name and

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

1. In the Data Sources panel,
click Add File Data Source >
SUP.

its suffix (for example, “Main”
and “Street”) so that the street
will be identified by both. When
you create tooltips for the roads,
the tooltips will display the
concatenated street name.

You must also specify the original

s E =

Data  Model Manage
Sources Explorer Surface Layers

s

Chapter 4 How do | get road data into Autodesk® InfraWorks?

coordinate system for the roads
(the coordinate system you

found in the PRJ file) so they are
located accurately. You will drape
the roads on the terrain so they
display properly on the ground.
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2. Open the .SHP file.

The data source is not configured
because a SHP file can contain
many types of data—you need to
specify the data type.

3. Double-Click the data source.
4. Give the data source a more
recognizable name.

At first, the configuration screen
has very little information.

I; Select Files

Organize = New folder

[ Favorites Documents library
. TimyTown SF Streets
B Deskiop

4 Downloads

Name

z» Recent Plages O ostelines.shp

-] Libraries
" Documents
o Music
=, Pictures
!, Videos

|

File name:

Data Sources

Group by: |[Feature Type ~ Show: All

RB-8B & X R %

Hama Source Type
Vector
Bl ortho_e1-1_s_cal75.5d Raster

il Terrain
B USGS SF DEMs Raster

=X

Amrange by:  Folder =

~ | SHP Files (“shp)

Date Loaded

ot Configured

Imported Tuee Oct 16 2012

Imported  Tue Oct 16 2012

Con

General

Hame

val I

Chapter 4 How do | get road data into Autodesk® InfraWorks?
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5. For Type, select Roads to see
more fields.

Genaral

MHame

External I Featld
6. To make the roads easier to Descrigtion
see, click the pencil icon in the
Rule Style field and select a
visual style for the roads.

Lanes Fonaand

7. For the Name field, use

the Expression Builder to z - b -

concatenate the STREET attribute Property Operator | Math Function  Text Function

(the street name only) and the = o e =82 2 =L 2| LKE| | |AND
ST_TYPE attribute (“Street,”

“Avenue,” and so on).

il
%ELI:

Concat ( STREET, ', ST_TYPE )

> Click in the Name field.

> From the Text Function
drop-down, select Concat.

> Replace the property
placeholders with STREET and
ST_TYPE by selecting them from
the Property drop-down.

> After the comma that follows
the STREET property, enter a
single quote, a space, and another
single quote

Chapter 4 How do | get road data into Autodesk® InfraWorks?
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I3 Data Source Configuration o o m - — w

> Delete the part of the
expression between the end of
the ST_TYPE property and the
end parenthesis until it looks like
the illustration here.

> Click Validate.

> Click OK.

8. Click the Geo Location tab.

Specify the coordinate system you
found in the PDJ file. Be sure to
specify the coordinate system with
the F at the end, indicating Feet.

Chose & Refresh

9. Click the Source tab and
specify Drape.

Draping Cptions

Drape

Convert closad polylines to polygons
10. Click the Tooltip tab and enter
a tooltip.

> Type % to see a list of
properties.

Tooltio

SHAMEY:

> Select the NAME property.

— S
Chapter 4 How do | get road data into Autodesk® InfraWorks? / 35
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11. Click Close & Refresh.

When you zoom in, you can see
and select individual streets.

If you right-click a street and
select Show Tooltip, the street
name displays.

© © 0 0 0 0 00000 0000000000 000000000000 000000000000 0000000000000 0000000000 0000000000000 000000000 0 0

Extra Credit: How do | retrieve railway data?

Use a state source to find railway data.

- Skip to Prosncty | Gontens | Egoter | acemgitey [Wpeesr ()
1. Use the Cal-Atlas Geospatial GOV SE%&TIEM g}ﬂ,;l; %{(}2 L Sl il Al T

Homa

Geospatial Clearinghouse to
find railway data.

Discovar | Download | Contribute | View

Projects ETEIUTUTTE 00D I € isced o

y | Bepeet By

in et fegheed

Summary Tracker

Go to https://atlas.ca.gov/ -.m‘-' . . e
frs/?group_id=135 Goounoh BEalon o s vorion) hics

Date

[P inchcinge: Firzrimmae:
m Sire DL JArch Type |

2. Download the RailroadsTiger. « Whie Paper Dutings NATIONAL HIGHWAY PLANNING NETWORK =1
- . . . . - Bunefit of bnlegrated 200 -
zip file by clicking it. Sooscencs T s
nhpolio 2008 zip 475 MB 2117 Any  GIS ARGANFO SHP sip
More.,, EX 2008 0081117 18:31
Extract the file to a sub-folder of e T T A e AR )
your Transportation folder. S TIGER - LOCAL ROADS (2
2007 Tiger 2008-12-08 20:51
» CEIC LocalRoadsTiger shp sl 43 KR 2787 Any  GIS FGDC Matadata ol
:SHW.E& [ Ccafamioecos TRIGGME 4073 Any  Gio ARGANED GHP o
3. In Autodesk InfraWorks, use Cotdtas oy o L e TS 2]
the Data Source panel to add OROAMZATIONS e B i itememe el

RailroadsTiger.shp.

Chapter 4 Extra Credit: How do | retrieve railway data? '
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4. Double-click the file to
configure it.

5. Set Type to Railways.

6. Map the Name field to
FULLNAME.

7. Select a rail style.
8. Click Close & Refresh.

To see where the railways are,
highlight them.

9. Close the Data Sources panel.

10. Display Model Explorer.

11. Right-click the Railways layer.

12. Set the Highlighting Color,
if desired.

13. Select Highlight.

The railways are highlighted in
your model.

Name

Description

Common Geo Location

General

Name FULLNAME
External ID | Featld

Description

Lanes
Elevation
Elevation Offset
Elevation Offset From

Elevation Offset To

8@ =

Data Manage
Sources Explorer urface Layers

Tooltip Table Script

Lifespan

Creation Date

Termination Date

Rule Style

Close & Refresh

& Properties
8 Data Table

Chapter 4 Extra Credit: How do | retrieve railway data?
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Extra Credit: How do | retrieve bike path data?

Use a state source to find bike path data.

1. Use the San Francisco
Metropolitan Transit
Commission site to find
bike path data.

GO .'gle san francisco metropolitan transportation commission

Web Images Maps Shopping More - Search tools

About 508,000 results (0.35 seconds)

Metropolitan Transportation Commission

www.mtc.ca.gov/ ~

Regional planning organization for roads and transit in the San Francisco Bay Area,
California.
Google+ page - Be the first to review

< 101 8th St Oakland, CA 94607
' (510) 817-5700

About MTC Schedule

MTC - MTC Commissioners - Please contact the MTC Public
Directions to MTC - Key Staff Information Office to verify all ...
Jobs and Contracts Meetings and Events
Employment Opportunities. Review Meeting Schedule. Dates, times and
current job openings ... locations for upcoming ...

About MTC -- Staff Directory Transportation 2035

MTC Staff Telephone Directory. MTC “Transportation 2035 has been a
staff photo (click to ... collaborative effort,” explained ...

More results from ca.gov »

2. There are many links on the
home page, but you can shortcut

(/’\ METROPOLITAN TRANSPORTATION COMMISSION
M T

. . , ———————————— RELATED SITE§ —M ———————— SEARCH MTC SITE
the process by searching directly \ / s - msm BATA :F sécurPer N
for Shapefiles. ; - v SO

3. The first entry in the results
list seems to have actual files to
download.

maps and data
| Web  Image

Planning, financing and coordinating transportation for the nine-county San Francisco Bay Area

All results Show Recent MNews Events Projects Funding Planning

4. Scroll down the resulting page Library

to see transit-related files. About 1,630 results (0.26 seconds)

5.9 MTC -- Maps and Data

: Oct 31, 2012 ... Spatial Library. The Spatial Library on MTC's Data

Portal includes geospatial and tabular data for the nine-county San

Francisco Bay Area.

www.mtc.ca.gov/maps_and_data/
Labeled Show Recent

GIS Data - MTC -- Maps and Data - Metropolitan Transportation
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5. Click Bay Area Bikeways in
San Francisco City/County to
download the data.

6. Extract the data to a sub-folder
of your Transportation folder.

These files had names that

were not very descriptive, so we
renamed them to include the term
“bikepaths.”

7. Bring the data into Autodesk
InfraWorks using the same
methods you used for streets.

Category 2

Bay Area Transil Geodalabase (4% of Novembar 2003)

Bay Area Transil Shapefiles (A5 of November 2003)

Bay Area Bikeways (all @ countes)

Bay Area Sikeways in Alameda county only Eliki Alameda Zip

Bay Area Bikeways in Contra Costa county Bikg Coniry Cosih I

Bay Area Bikeways in Marin county Bike: Marin 7ig

Bay Ared Bikewdys in Napa county B Napa Zip

Bay Ared Bikewdys in San Frantisto Cityioounty Bia San Francieco Fp

Bay Ared Bikeways in San Mabed county Bike San Maled Tio

Bay Area Bikeways in Sofano county Bike Sofang.zip

Bay Ared Bikeways in Santa Ciara county Bin Sanla Clara Zip

Bay Area Bikeways in Sonoma county B&a Songma Zip

O_O [ ). = San Francesco Project » Transponation » Bike Patrs w [y || Secrch Bike Paths 2]
File Edit View Tools Help — —
Organize = Iacludeinlibrary = Sharewith = Bum  Mew falder i- T @
L TinyToan A Name : Date moditied Type size
B Desiaop R R i
TanCIS00, i 3Kl
" # sa:-j au'm_b'xmm Z
rancised_bil
b Recent Plages -
San_francisoo_bikepathsihg 431 KB
o =l San_Francisoo,bikepaths shpaml IO KE
ool Libraries 5 =
B San_Francices bikapathe s TR |
. Decuments L
o Music

. Pictares

p by: Fealure Type = Show: Al

R-8 R X R S e

Hame Source Type status Date Loaded
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Water data is also called hydro or
hydrology data.

Water data is always in vector
format, and is often stored in ESRI
Shape files. Shape files come in
sets, and you must have these
three:

File Purpose
Extension
SHP Geometry. For water, this is line

geometry or polygon geometry,
but polygon geometry is preferred
because it looks more realistic.

DBF Attribute information

SHX Links together and indexes the
other two files.

Downloads mayalsoinclude
a PRIJfile, which contains
projection and coordinate
system information.

HOW SHOULD | STORE
WATER DATA?

Use these guidelines when storing
water data:

1. Create a Project folder to
organize all your data.

2. Create a Water Data folder for
each project.

3. When you extract the download
zip file, create a target folder for it
under the Water Data folder.

Name the target folder something
recognizable, and include the
source of the data — for example:
SF City Water Data.

You can use your web browser
search string, for example,
including the following: GIS + data
+ download + water + [your area
name]

GIS

A Geographic Information
System stores, manages,
and analyzes geographical
information.

Download

Include this term to avoid sites
that merely display terrain data
without the ability to download it.

Your Area Name

Start with a small area and
expand from there. For example,
specify your city or county name.
Include the state name to make
sure you get the right data.

In this lesson, we will use data
from the City of San Francisco.
The Extra Credit exercise uses a
service called WeoGeo.

As you look for water data, keep
these tips in mind:

> Look for a “resources” or
“interactive tools” link on the

page

> Do not download maps—you
need the raw resources to create
a map

> Look for hydrology data

> Check any posted metadata to
find out the coordinate system for
the data

> |f data is tiled, check on an
overview map to see which tiles
you want
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How do | retrieve water data?

1. Go to www.data.sfgov.org.

San Francisco Data &

2. On the left of the page you'll
find the search field. In the search
field, type Water. T

Clear All Options

View Types
[ Datasets
Charts
Maps
[ Calendars
Filtered Views
External Datasets
Files and Documents

E] Forms

Results for "water "

3. The first entry in the results is Name
what we want. Click its title. Water Bodies in San Francisco ((Zipped Shapefile Format)
’ Water bodies in 5an Francisco. Derived from city features drawings from DPW. Modified by
DT to show type of water body and name.

Beach Water Quality
’ Working with the San Francisco Department of Public Health (SFDPH), we jointly administer

the beach water quality monitoring program in San Francisco. Both agencies participate in
sample collection; the San Francisco Water, Power and Sewer Microbiology Laboratory
performs bacteriological analyses.

Sign Up Sign In

4. On the resulting page, click the San Francisco Dat"

ZIP button to download the water
SHP flle (k4| Water Bodies in San Francisco ((Zipp...

Water bedies in San Francisco. Derived from city »

This data extraction tool or application is available via the External Link

link to the right

5. Save the file to your local drive.

Chapter 5 About Water Data
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How do | get water data into Autodesk® InfraWorks?

Import and configure the water
data, much as you did for the
transportation data. In this case,
you do not need to specify the
coordinate system—Autodesk
InfraWorks is able to determine it
from the data source.

1. In the Data Sources panel, click
Add File Data Source > SHP

2. Open the .SHP file.

The data source is not configured
because a SHP file can contain
many types of data — you need to
specify the data type.

Chapter 5 About Water Data

Data Maoadel Manage

Sources Explorer Surface

i Data Table I =

Organize = MNew folder

; Favorites . Documents library
L. TinyTown Water

B Desktop

h Downloads
< Recent Places

Name
A phys_waterbodiesshp
~ Libraries
*» Documents
<. Music
= Pictures
B videos
N CCSSCR1490WL2 = 18l

File name: phys_ waterbodies.shp

Ar range by E

|SHP Files (*shp)
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3. Double-click the data source.

4. Give the data source a more
recognizable name.

5. For Type, select Water to see
more fields.

Chapter 5 About Water Data

Data S

: Featwre Type = Show:

B-2 B

Name

[ phys_waterbodies

Narme:

Al
L <

Source Type

Vector

® w

Status =

Mot Configu

Hide Details
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=

6. Use the drop-down lists next to
each field to map the attributes in

the SHP file to the attributes in the
model.

For example, this SHP file has an
attribute called BODY_NAME. You
can map that to the Name field for
Water in the model.

For any fields that don’t have
equivalents in the SHP, leave the
value blank.

7. To make the water more
realistic, click the pencil icon in
the Rule Style field and select a
visual style for the water.

8. Click the source tab and
specify Drape.

9. Click Close & Refresh.

Chapter 5 About Water Data
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When you zoom in, you can see
the styled water.

© © © 0 0 00 00 00000 0000000000 00000000000 00000000000 0000000000000 000000000 0000000000000 000000000 00

. UJeO eo Home | Market | Showcase | AboutUs | Support | Contact
The WeoGeo service aggregates W S

GIS data in a single portal, making
it easier to find the available data
for a particular area. Some of _ J b Yk |
the data is free and some of ) Y. L P

is fee-based. Map Data. On Demand.

What can we help you find?] Aerial Imagery, Rozds, Topo, ...

Or you can browse our Market to find your spatial data.

1. Go to http:// www.weogeo.
com.

SeaZone b

2. In the Search field, type Featured Data
San Francisco. DigitalGlobe Precision Aerial
FU - DigitalGlobe's Precision Aerlal delivers the Industry's first high-quality, wall-to-wall collection of 30
DlgltalGlDbe’ em natural color (RGE) aerial orthomosaics covering the contiguous United States and Western
Europe.
3. Register with the service so you Intermag
can download data |N'|-d?.M\P Intermap provides some of the most h, q 15 and I ion data ilable today.

Their high-resolution NEXTMap data preducts provide seamless, wide-area, and current terrain
information for the United States.

Chapter 5 Extra Credit: How do | use WeoGeo service to retrieve 'ata? -
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4. Enter your information and
click Create Account. When you

Let's create your account...
receive confirmation, sign in with

Sign up using your account with

Already have an account with

your new credentials. | Focebook | one of these senvices? Yo
can use it to spe: up the
| Gaogle | registration process.

| Yahoo! |

# Subscrioe o newsletter and marketing emails.

OR

First name Last name Hi, we're WeoGeo Market,
please tell us your name.

Emall Address Confirm Email Address Your email address will be

suzi@simereative.com your username. We will also
use your email address to
contact you once data Is ready to
download.

Password Confirm Password Your account password can be

— anything you want, but must be
between 4 and 40 characters.

¥ Subscribe to newsletter and marketing emails.

Terms of Use | Privacy Paolicy

Cw weogeor P

5. Double-click to zoom into the

San Francisco area to see the Search & Results
available datasets. SRS X
Advanced Search Search Help
TIGERILine - San Franciaes Caunty, X l'_ﬂ
TIGER/Line 201 Data for San H
Francisco Ctmnl)'. CelforniaThis:
Isting is for COUNTY based

wecter Free

USG5 DRE Tapa San Frenciss

United Ste1es Geological Survey
USG5} Topographic meps detail
the shape and elevation of the
raster Free

TIGERLine - San Mateo Covnty,
TIGERLine 201 Data for San
Mates Caunty, CaliforriaThis listing
is for COUNTY based TIGER/Line
vector Free

USGS DRG Topa San Francises
United Stetes Geological Survey
USG5} Topographic maps detail .
e shage gad elevation of the ik
raster Free
DigiakGiobe: San Francisen, CA.
Precision Asrial Imagery & 4

high-qualty, seamless collection of
20 ern natural color RGE) aecial

raster Starting at S40.05 JUSD}

OpenStreethap: San Francisco, CA
This listing on WeoGeo gims 10
allaw for mive efficien data
ECESS 10 the ever grawing

veetor Free

Imermap - NEXTMep [DTME Sar

Intermap's NEXT Map Digital
Termain Model [DTM) is & bare-earh
model with & resslution of 5

Chapter 5 Extra Credit: How do | use WeoGeo service to
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6. The last item on the list is ﬁ UJE’OQ%%"

water polygons. Click it to see

information about it. Search & Results
Son Francisco »
Advanced Search Search Help

USGE DRG Topa San Francison

United Setes Geological Sureey
USGEE]} Topographic maps detail I ™
the shege and elevation of the ‘1
rasber Free

DigiaiGlobe: San Francsco, T
Presision Aerial Imegery & a
high-quality, seamless collection of
30 ern netural calor REE) serial

raster Starting at: 40095 [USD)
OpenStresMap: San Francios, CA

This listing an WeoGeo gims 10 &
allow for more efficient data

BOCEES 10 the ever growing

o Fres

Intermap - NEXTMa [DTM}: San

Intermap'’s NEXTMap Digital
Tersin Madel [DTM) is & bare-eath
mindel with & resolution of 5

raster Starting at: $40,00 (USD)

OpenStresiMap Data Water

Far mappers in need of 8 -
dedailed, convenient, and
open-source base Layer, this
iihor Froe

DigiakSlobe: United States Aerial
Precision Aerial Imagery i a

high-guality, seamless collection af

30 ern ngtural calor [RGB serisl

raster Starting at: $49.95 {USD)

OpenStreetMap Data Water Polygons

|

7. Click the Details button.
Weobeo

For mappers in need of a detalled, convenient, and open-source base
layer, this dataset is a great option. Jochen Topf cleaned and extracted
major water bodies from OpenStreetvap and converted them into
shapefiles, making this rich but hard-to-use data much more accessible.
The process invohled using OSMCeastline, and fixing or removing
incorrect data and combining separate pars into a useful whole.

This dataset includes polygons with detailed shorelines for all cceans,
bays, and major lakes. For ease and speed of processing, polygons

were split into smaller overlapping pleces. The small overlaps prevent
rendering anefacts at the seams.

Chapter 5 Extra Credit: How do | use WeoGeo service to retr



8. Read the description and click ﬂm Free Full Size: 434 MB

Order All. ) )
Map Tools: n | Sl mL | -)( Reset Options

Datum-Prajection: Native -
File Farmat: ESRI Shape -

For
this dataset Is a great option. Jochen Topf deaned and extracted major water
bodies frem OpenStrectMan and converted them into shapefiles, making this
rich but hard-to-use data much more ible. The p i hed using

mappers in need of a detailed, convenlant, and open-source base layer,

OSMCoastline, and fixing or removing incorrect data and comblning separate
parts Into a useful whole.

This dataset includes polygons with detailed shorelines for all cceans, bays,
and major lakes. For ease and speed of processing, pelygons were split into
smaller everapping pieces. The small overlaps prevent rendering artefacts at
the seams.

There are no attributes in this dataset that can be used for labeling, but the
resolution is excellent, as is shown In the screenshots below:

San Francisco

9. Fill out the form, accept the Order Dataset

x
terms, and click Order Now.
Note Content License
1A comment to distinguish this order from This data Is provided under the Creative
others. Commons Attribution ShareAlike 2.0 license. You
must accept this llcense to order a copy of this
data.

# Accept this content license

Price: Free

oter 5 Extra Credit: How do |




10. Review your order and
Click Next. Review | Choose Payment | Place Order Total: $0.00

DVD Dellvery
In addition to downloadable files, deliver this order on DVD(g). Add to Order
Price: $10.00

OpenStreetMap Data Water Polygons - WeoGeo
Content License: Creative Commons Attribution Sharedlike 2.0

Show Details Price: Free

11. Click Place Order. Review | Choose Payment | Place Order Total: $0.00

# Make my contact information available to the owner of the data product | am srdering.

Contact Information edr

Your Mame

123 Your Street
City, State 00000
United States




e 2
Autodesk® InfraWorm_ ining Guide

You will receive a confirmation of ﬁ weogeo
your order, and then another email
with a link to download the data.
Order Confirmation

12. Unzip the contents of the
downloaded file to the Water Thank you for ordering from WeoGeo! Your order confirmation number is

folder in your project folder. 01023570.

Your requests have been added to queue. Please keep in mind that large,
complicated data listings may take a while to process. We appreciate your
patience.

Once your order has finished processing, you will receive an email containing a
link that will direct you to your download. The download links will remain active
for 7 days, and will then be removed.

Thank you for using WeoGeo.

Best regards,
The WeoGeo Team

Order Details

Items Requested: 1
Date of Request: 06/01/2013

1. Listing Name: OpenStreetMap Data Water Polygons
Job Number: j46037
Cost: Free

Follow us on: G 0 @

1

- |
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You can download building
footprint data, and then style

it to resemble actual buildings.
While the footprint data shows

the building foundations only,
Autodesk InfraWorks can display
three-dimensional buildings based
on data in the files or in styling
information that you provide

Building data is always in vector
format, and is often stored in ESRI
Shape files. Shape files come in
sets, and you must have these
three:

File Purpose

Extension

SHP Geometry. For Buildings, this is
polygon geometry.

DBF Attribute information

SHX Links together and indexes the
other two files.

Downloads may also include

a PRJ file, which contains
projection and coordinate system
information.

HOW SHOULD | STORE
BUILDING DATA?

Use these guidelines when storing
building data:

1. Create a Project folder to
organize all your data.

2. Create a Building Data folder
for each project.

3. When you extract the download
zip file, create a target folder for it
under the Building Data folder.

Name the target folder something
recognizable, and include the
source of the data — for example:
SFData Buildings.

HOW DO | FIND BUILDING
DATA?

You can use a web browser
search string, for example,
including the following: GIS + data
+ download + buildings + [your
area name]

GIS

A Geographic Information
System stores, manages, and
analyzes geographical information.

Download

Include this term to avoid sites that
merely display terrain data without
the ability to download it.

Your Area Name

Start with a small area and expand
from there. For example, specify
your city or county name. Include

the state name to make sure you
get the right data.

In this lesson, , we will use a City
of San Francisco site for buildings.

As you look for water data, keep
these tips in mind:

> Look for a “resources” or
“interactive tools” link on the

page

> Do not download maps—you
need the raw resources to create
a map

> Check any posted metadata to
find out the coordinate system for
the data

> Check the metadata for
attribute data as well. If the
attribute data is stored in a
linked database, you will not get
information like height, roof type,
etc., but only the shape of the
building’s footprint. The attribute
data will make it possible to
create much more realistic
buildings.

> |f data is tiled, check on an
overview map to see which tiles
you want.
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How do | retrieve building data?

In this exercise, you will retrieve
data from a city-sponsored site.

1. Begin your search by
entering the search string
in your browser.

It looks like the City of San

Francisco has some download-
able data.

2. Search for building footprints.

3. The result we want is Building

Footprints (Zipped Shapefile
Format). Click its title.

Chapter 6 About Building Data

Google

=

gist+data+download+buildings+san francisco

Web Images Maps Shopping More ~ Search tools

About 2,050,000 results (0.28 seconds)

SFGov : San Francisco Enterprise GIS Program - SFGIS
sfgov3.orgfindex.aspx?page=3959 -

Mar 26, 2013 - The San Francisco Enterprise GIS Program (SFGIS) provides the ...
Updates to the City's 30 Building Model; Demographic Data; Business Data ...

Data | San Francisco

www.datasf.org/ ~

The San Francisco Data App Showcase is a collection of applications that .... This data
layer shows building footprints for the City and County of San Francisco ...

Digital Spatial Data - HSU Library
library.humboldt.edu » ... » Geospatial Resources (Maps, GIS, Imagery) ~

Feb 19, 2013 — GIS Data Depot (Geocommunity) Includes GIS data for the individual
countries ... GeoSpatial Data Downloads (US Bureau of Land Management. ... San
Francisco Bay Area Regional Database (BARD) (U.S. Geological Survey ...

GIS in the Earth Sciences & Map Library

www.lib.berkeley.edu/EART/gis.himl ~

Jun 10, 2011 = The majority of the library's collection of GIS data is available on
CD-ROMs and DVDs. ... Eco-Atlas San Francisco Bay --modemn and historic datasets;
ESRI Data ... Building footprints - Choosing the right geographic transformation ... In
addition fo the downloadable data files in shapefile and raster format, ...

S DBveloper About SFGov

Third-Party Spending in Support or 3,735 views
oTpCandig

= OPpposition

ates — November 6,

o 2012 Election

San Francisco Campaign and Governmental

Conduct Code ("s.F. C&GC Code") sections

1.143(c), 1.152(a)3), 1.161(b), 1.161.5, and

1.160.5 require persons who make any

independent expenditure, electioneering
communication, or member communication that
clearly identifies a candidate for City elective

office or who authorizes, administers or pays for b4

Sign Up Sign In

Building Footprints (Zipped Shapefile

L’l Format)

This data layer shows building footprints for the
City and County of San Francisco as of June 2011.
The layer was created using the ArcGIS 3D
Analyst conversion tool, "MultiPatch Footprint,”
converting the 3D building model data the City
licensed from Plctometry, Inc.

w
un
5]
[
<=
m
W

SFPD Reported Incidents - 2003 to 2,321 views
L’l Present

Incidents reported via the SFPD CABLE System,

from 1/1/2003 to

resent. In KML format
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SFCov

About

SignUp  Signln

4. On the resulting page, click | San Francisco Data
the ZIP bUtton tO download the Building Footprints (Zipped Shapefile Format) =]
. 0 . This data layer shows building footprints for the City and »

building SHP file. e e

Eé(slgatl::;g::tion tool or application is available via the External Link
Description

‘!fhis data layer séww_s bu‘-rlkdl.:g fé;]glggr::s flw the City and Cou‘ng',:lllofi s:n Fﬁ_ncisco_as_ofjune 201!..hThseD Jrzﬂ;‘!&']g:%';' 2012
Bullding model data the City icensed from Pictometry, Ince o e g e opdaced oy 12, 2013
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How do | get building data into Autodesk® InfraWorks?

Import and configure the building data.

When you configure the data, you will use one of the building attributes to determine the height of each
building. You may need to contact someone familiar with the data to find out which attribute represents
building height.

You will also assign a style to make the buildings look more realistic. All buildings will use the same style
initially, but as you import 3D models (in the next lesson), you can replace some generic-looking buildings
with models that represent the actual buildings.

1. In the Data Sources panel, , =’J
click Add File Data Source > Data Model  Manage
SHP. Sources Explorer Surface Layers

=

. crt
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2. Open the .SHP file.

The data source is not configured
because a SHP file can contain
many types of data—you need to ¢ Favorites Documents library

: L. TinyTown
specify the data type. W Deskiop

Organize = MNew folder

Arrange by:  Folder =

Mame

ls Downloads
i -
%5 Recent Places 1 building_footprintshp

" Libraries
*» Documents
<. Music
5. Pictures
B videos

s COSSCRI490WL2 = o

File narme:

3. Double-click the data source.

: Feature Type -~

R-8 B X B "t 9

Hame Status
M <MNo Feature Type:

B building_footprint Mot Configu

Imparted

Imported g

4 b

o Hide Details

Data Source Details

building_foatprint

iilding_footprint.shp™;
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£ Data Sowce Configuration

4. For Type, select Buildings to
see more fields.

5. Give the data source a more
recognizable name.

6. Use the drop-down lists
next to each field to map the
attributes in the SHP file to the
attributes in the model.

> For example, this SHP file has
an attribute called jobname. You
can map that to the Name.

> Map the BoxZSize attribute to
Roof Height to vary the heights of
the buildings.

For any fields that don’t have

equivalents in the SHP, leave the
value blank.
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7. To make the building facades A¥ select Style / Colo

more realistic, click the pencil .
icon in the Rule Style field and

gl Focade/Brick
select a visual style. “ E m ﬁ

Biron

NOTE: Since we don’t have

attributes for these items, all E ﬁ - m

buildings will use the same

facades and roofs. ; ﬁ E @-@ Tt
bbbl

Source Filber

8. Click the Source tab and
specify Drape.

Draping Options

Convert closed polylines to polygons

9. Click Close & Refresh.

When you zoom in, you can see
and select individual buildings.
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Three-dimensional models are
real-world representations of
individual objects. For example,
you can find 3D models that
represent real buildings in your
area, or generalized models for
city furniture, such as bus shelters
or park benches.

3D models are often stored in
the FBX format, which is the
main exchange format used by
Autodesk Revit, Inventor, and
Civil 3D. You can also find 3D
models in the 3DS format used
by 3ds Max or 3ds Max Design,
as well as in DXF, OBJ, and DAE
(Collada) files.

HOW SHOULD | STORE
3D MODELS?

Use these guidelines when storing
3D models:

1. Create a Project folder to
organize all your data.

2. Create a 3D Models folder for
each project.

3. When you extract the
downloaded zip file, create a
target folder for it under the 3D
Models folder.

Name the target folder something
recognizable, and include the
source of the data—for example:
TurboSquid Building Models.

HOW DO | FIND 3D MODELS?

You can use a web browser
search string, for example,
including the following: Free +
“3D models” + download

As you look for 3D model data,
keep these tips in mind:

> The TurboSquid and Google
Sketchup 3D Warehouse
sites are good sources for

architectural models. TurboSquid
can be expensive for building
models.

> If you are preparing a model
for a client, that organization may
have 3D models in-house. Ask if
you can use them for the project.

> In the Google warehouse,
search by area to see what’s
available.

> Click a model to view it.

> Select 3D View to orbit it.
> Make a note of the
creator so you can credit
that person.

» Click Download to
see available formats and
download

> Click Map tab to see
location of model in the city
and what other models are
available in that area
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How do | retrieve 3D models?

There are many sources for 3D models, but finding them in the right format and at no cost is challenging.
The example here was on the Google warehouse site at the time of this writing, but the contents of the site

change frequently.

1. Begin your search by
entering the search string in
your browser.

We’ll go directly to the 3D
Warehouse.

2. Search by collections to find
multiple buildings. Enter the
search string for your area.

3. Try the large collection of
buildings called San Francisco,
CA USA.
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Google

free 3D models download google warehouse

Web Images Maps

About 310,000 results (028 saconds)

Shapping

Applications

Mara - Search tools

sketchup.google. com/3dwarehouse =

Free 3D modeling software. 30 Warehouse FAQ Learn about the 30 Warchouse.
Google Earth Search the globe for 3D models. 30 Warehouse forum, Connect ...

Google 3D Warehouse - Welcome

www.geogle.comfintlen/sketchupl3dwh

J -

Download Modealing Guide. Learn how to model for Google Earth ... The Google 3D
Warehouse is a free, online repository where you can find, share, store, and collaborala
on 30 models. The easiest way to share your model of a place with ...

@!‘Trimble' 3 D Warehouse [ san francisco

| (collections |+ (‘search

powered by GO()S[C

3D Collections
Create or contribute to a 3D Collection.

3D Warehouse Collections Results

San Francisco's 10
Tallest...

10 tallest...

Updated Nov 2, 2010

9 models

Templo v exconvento de
San...

El Templo y exconvento de
San...

Updated Oct 30, 2012

2 models

San Francisco
International...
IIIII B
dr ¥ dr dr dr \__-_-——
(2 ratings)
72 models San Francisco International... 3 models

Updated May 3, 2012

San Francisco, CA, USA

(8 ratings)
This is a collection of...

-t ==3 |pdated Dec 15, 2009
65 models

Sorted by relevance

610 models

17 models

21 models

Presidio of San
Francisco,...

(8 ratings)

The Presidio of San
Francisco...

Undated Mar 19. 2013

San Francisco
International...

(2 ratings)

San Francisco International...
Updated Jan 10, 2010

The San Francisco
San Francisco Models
Updated Dec 31, 2009

San Francisco

(1 rating)

Models in San Francisco
Updated Mar 24, 2012
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4. On the fourth page, click the
San Francisco City Hall model
to view it.

5. Click 3D View to rotate and
view it from all sides.

6. Click Download Model to
save it to your local drive. Use the
Collada format.

7. save and unzip the contents
of the downloaded file to the

3D Models folder in your project
folder.
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How do | get a 3D model into Autodesk® InfraWorks?

We are going to use the 3D model we found to replace the generic building it represents. In order to do that,

we must import the 3D model as a style in the Style Palette. Then we can apply the style to the building.

1. In the ribbon, click Home tab
> Stylize Model panel > Style
Palette.

Stvie Palette

2. In the Style Palette, click the
3D MOdeI tab Catalog Editing

d 30 Model/Buildings

u ]|

re i Lee FORRS O M

-
parent>

£ LIt
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' Style Palette

3. Click the plus sign at the
bottom of the Style Palette. Catalog Editing

L\ —
T A n 2 g

&% 3D Model/Buildings

HE M =E =

EpSea= Fumniture Neighborh... Residential

Coverage Barrier

Facade

Style Editing

:
9
8
::2

+ X " %% m /

4. Click the ellipsis button next
to Model URI.
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5. Navigate to the folder storing
the 3D model.

6. Select the model and

Aoced i
ok Open 7 SonFancico et » 30 Vodds » moses =]

ey 1

Favorites :]QEI.,arT"E."'IfS :ID'EF':,'
TirnyTowm
B Deskrop

4 Downloads

I e gl

25 Becert Placet

o Libraries
Docurments

a. Ml

e PICDUNeES

'. Nideaot

= | 3D Model Fibes (*Jox *3d * =

Candel

7. Click OK in the Define New
3D Model dialog box.

- ]
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8. The new model appears in the
Style Palette.

Catalog Edting

-
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How do | use a 3D model to replace the building it represents?
You replace a building with a 3D model by applying the 3D model to the building as a style. First, locate the

building to replace, then apply the style.

1. To find the building, first look
up its address. The address of
City Hall is 1 Polk Street.

Looking at the map, we can see
that City Hall is on Polk between
McAllister and Grove. We can
also see that this section of Polk
is actually called De Carleton B.
Goodlett Place.

Google

City Hall, San Francisco CA

2 Z r ry St i
_ st & 1000 Van Geary rFarrell St
Gat directions My places = (eo| 1 VS Mozt LS‘E L llis 5!
Bl }i B grarel ?:r-a s St Powell Stk
CAN_ W AL -
e St st a
: : w = TENDERLOIN % 8,
City Hall, San Francisco CA s S = i
2 POLK st s )
. 2, GULEH § Turk A
Bl 3 s L
e S m g L
. giu S B otokst S g e&e} s &
1 Dr Carlton B Goedlett Pl, San Francisco, . F
CA Tur UG Hastings A i L
EER h (1] Ccllrl‘Pr:Po! - k= Aida Plaza
- > % £ s e Law a
&,
m 77 reviews - anan S inn At The Fulton % g Civie Center/ o %
! Mall e e San Francisco & ez ss@ w4
Elrt!'llur brown jr - rna“?jr gavin newsom - earthquake - 5 e Public Library u o — ".'50 %
. n
civil ceremony - walking tour b . 3 N
"Probably the most majestic City Hall in the USA. c < ; MARKET
Remember when people ..." - L3 Hayes St E] " ‘94} & G
w3 z G & G S Vic
AN eSSl & & & g
Directions Search nearby Saveto map more~ = tJ SAN
x5 2 FRANCISCO /. N
<, 2
® “y %, * “ shell @
a5t & 4’%} R r
r—lm(r\cm o & o 9/4
Report & problem - Maps Labs - Help CO“““L“‘.I.?, o o 5’5 I & /e (1)
= 27
Google Maps - 2013 Google - Tarms of Use - Privacy enter v 3, § o oé\ Costco
anStg !‘; Zeitgeist i ‘,;é? a
a i 11 Clentral Fi:
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2. Click Home tab > Explore ome | View  Analyze

panel > Model Explorer to see B £

the Model Explorer. Data | Model  Manage
Sources Explore Surface Layers Selected

=

3. Right-click the Roads layer
and click Select By Filter.
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B

4. From the Property drop-
down, select NAME, and then
click the equals sign.

5. Click the green arrow next
to Get Values.

6. From the drop-down list, select
Name.

TAG
TOOLTIP [ —
USER_DATA
MODEL_SPUT —
MODEL_VISIBLE
REVERSE_DIRECTION
ELEV_FROM
ELEV_TO
ELEVATION_OFFSET
| GENERALIZATION

)
IMPORTANCE
LANES_BACKWARD
LANES_FORWARD
MAX_SLOPE
MAX_SPEED —
MODEL_ROTATE_X
MODEL_ROTATE_Y
MODEL_ROTATE_2
MODEL_SCALE_X
MODEL_SCALE_Y
MODEL_SCALE_Z bl

i

= |



7. In the filter THE LIST OF
VALUES field, enter Carlton and
click the green arrow again.

8. Click Insert Value.

MAME - DR CARLTOM B GOODLETT FL' |

9. Click Validate.

10. Click OK.

The expressson is valid

Ctear [ Zoom Extents £ Show Location | Options ~ Getting Started
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11. Click Home tab > Explore
panel > Zoom To Selected.

The view changes to show
Dr. Carlton B. Goodlett Place.
The building next to it is City Hall.

12. Drag the model from the
Style Palette and drop it onto
City Hall.

13. You can view City Hall from F = __ : gl .
any angle. o o N

(2 Tﬁi&*"" 1)

[ — - Ib-—-...-._..__'___:'_;_'r—ﬁ
LT T,
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